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Icon Power Packing List

Icon Power is distributed with the following files.    

ICNPWR.EXE
ICNPWR.HLP
READ.ME
LICENSE.DOC
ORDER.FRM
Sample Icons

If you have received a copy of this program that does not include all of these files,    then you have 
received an incomplete package.    Please contact us at the following address for more information.

AZ Computer Innovations
Post Office Box 10514
Glendale, Arizona        85318



Icon Power License Agreement

This document and the program files ICNPWR.EXE & ICNPWR.HLP ("the software") are copyrighted by 
AZ Computer Innovations. You are granted a limited license to use and evaluate the software for a period 
of 21 days. You may also make copies of the software to give to others for their evaluation, provided the 
following restrictions are met:

o      Only unregistered copies of the software may be distributed. 

o      The software and the files READ.ME, LICENSE.DOC and ORDER.FRM shall be supplied in their 
original, unmodified form.

o      The software may not be included, or bundled, with other goods or services. Exceptions may be 
granted upon written request only.

o      No fee may be charged for the software.

o      Anyone wishing to charge a fee for the distribution of Icon Power must have the written permission
of the copyright owner, without which, the distributor is guilty of a copyright violation. For 
distributors already recognized by the Association of Shareware Professionals, this written 
permission is not required.

If you make use of the software after the 21 trial day period, you are obligated to pay a registration fee of 
$15.00 in U.S. funds to:

AZ Computer Innovations
Post Office Box 10514
Glendale, Arizona    85318

Upon receipt of your registration fee, AZ Computer Innovations will mail you a registered version of Icon 
Power and grant you a license to use it on any one computer at any one time. You must treat this 
registered version of Icon Power just like a book.    An example is that Icon Power may be used by any 
number of people and may be freely moved from one computer location to another, so long as there is no 
possibility of it being used at one location while it's being used at another.    Just as a book cannot be read
by two different persons at the same time. 



Warranty Disclaimer

Icon Power is provided "as is". There is no warranty of any kind.    The copyright owner will not be held 
liable for any damages, including any lost profit or other incidental or consequential damages arising out 
of or inability to use Icon Power.    By using Icon Power, you agree to this.
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Overview

Icon Power is a Windows 3.0/3.1 utility program that allows for the viewing and management of multiple 
Windows icon files.    Icon Power allows you to display as many icons as will fit into a display window that 
you position and size.    Using Icon Power you may:

o      View the icons contained within a disk direcory or contained within a Windows EXE or DLL file.

o      Open multiple icon viewing windows, each with it's own directory and file filter. Icon Power will 
remember the size, position, directory and file filter for each display window that is opened and 
recreate those same conditions every time the program is executed.

o      Easily copy or move icons from one directory to another by dragging the object icon from one Icon
Power viewing window and dropping it on another Icon Power viewing window.

o      Seamlessly replace existing Program Manager icons by dragging the replacement icon from an 
Icon Power viewing window and dropping it on the Program Manager icon that you wish to replace. 
(Feature available in under both Windows 3.1 and Windows 3.0)

o      Easily replace any icon contained within a Windows EXE/DLL file by dragging the object icon from
an Icon Power viewing window and dropping it on the target icon in the Icon Power window that is 
viewing the Windows EXE/DLL file.

o      Rename, delete, or edit selected icons directly from the Icon Power viewing window.



Copying Icons

Icons may be easily copied from one Icon Power viewing window to another by using Drag and Drop.    
Depress the control key on the keyboard and then click and hold the left or right mouse button on the 
desired icon and drag it over to the target window and release.    

If the target window is displaying icons that are contained in a disk directory, the object icon will be copied
from the source directory to the target directory.    

If the target window is displaying icons that are contained in an EXE or DLL file, the object icon will be 
used to replace an icon in the EXE or DLL file.    To indicate which icon in the EXE/DLL file is to be 
replaced, Icon Power will draw select boxes around the icons in the target window as the mouse is moved
around in the Icon Power viewing window.      When the mouse button is released over a valid icon in the 
target window, Icon Power will first open a dialog box to confirm overwriting one of the EXE/DLL icons 
and then replace the icon. The object icon in the source directory will remain unchanged.



Moving Icons

Icons may be easily moved from one Icon Power viewing window to another by using Drag and Drop.    
Simply click and hold the left or right mouse button on the desired icon and drag it over to the target 
window and release.    

If the target window is displaying icons that are contained in a disk directory, the object icon will be moved
from the source directory to the target directory.    

If the target window is displaying icons that are contained in an EXE or DLL file, the object icon will be 
used to replace an icon in the EXE or DLL file.    To indicate which icon in the EXE/DLL file is to be 
replaced, Icon Power will draw select boxes around the icons in the target window as the mouse is moved
around in the Icon Power viewing window.      When the mouse button is released over a valid icon in the 
target window, Icon Power will open a dialog box to confirm overwriting one of the EXE/DLL icons and 
then replace the icon. The object icon in the source directory will remain unchanged.



Replacing Program Manager Icons

Program Manager icons may be seamlessly replaced by using Drag and Drop.    Simply click and hold the
left or right mouse button on the desired icon and drag it over to the Program Manager icon that you wish 
to replace and release.    Icon Power uses a state of the art DDE interface to command Program Manager
to replace the target icon.    If you are running under Windows 3.0 and the "Backup Group Files" option is 
enabled, a backup copy of the affected Program Manager group file will be made before the icon is 
replaced.

This feature is available for both Windows version 3.0 and version 3.1.    



Icon Power Main Menu Items
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File Menu Items

The File Menu includes commands that enable you to view the icons contained in a particular directory, 
view the icons in an EXE or DLL file, set the program options, and exit the program.

For more information, select one of the File Menu topics listed below.

View Icon Files                                 
View EXE/DLL file                           
Options                                            
Exit                                                    



View Icon Files Command    (File Menu)

The View Icon Files command is used to specify the directory containing the icon files that you wish to 
view.    When the View Icon Files command is selected, a dialog box containing the following controls will 
be displayed.

o        Icon File Name Filter

Specifies the file filter to be used when reading files from selected directory.    The default value is 
"*.ICO" which specifies that only files with a .ICO extension will be read.

o        Icon Directory Path

Specifies the current icon directory path.    The desired directory path may be entered directly into 
this edit box or selected by using the list box control described below.    The default value is the 
directory from which Icon Power was started.

o        Directories List Box

May be used to select the desired directory by double clicking on any of the directories displayed in
the list box.    Click on the OK button when the desired directory has been specified. 

Once a directory has been selected, Icon Power will display it's path and file filter in the caption bar of the 
viewing window.    When Icon Power is terminated, the information specified in the View Icon Files dialog 
box will be saved into the "ICNPWR.INI" file and reused the next time Icon Power is started.



View EXE/DLL File Command    (File Menu)

The View EXE/DLL command is used to specify the name of an EXE or DLL file that contains icons that 
you wish to view.    When the View EXE/DLL command is selected, a dialog box containing the following 
controls will be displayed.

o        FileName

Used to specify the name of an EXE or DLL file whose icons you wish to view.    The value entered 
here also acts as a file filter for the Files listbox described below.    The default is *.EXE which 
specifies that only files with a .EXE extension will be displayed in the Files listbox.

o        Files Listbox

Used to select an EXE or DLL file whose icons you wish to view.    Double click on a file name to 
select it for viewing.

o        Directories Listbox

Used to select a different directory or drive to choose files from.

Once an EXE or DLL file has been selected, Icon Power will display it's path and name in the caption bar 
of the viewing window.



Setting Program Options    (File Menu)

The program options that are described below may be set or reset by selecting File|Options on Icon 
Power's main menu. A dialog box containing the following options will be displayed.    The options below 
are global and will affect all instances of Icon Power.    (See the topic on the Icon Power initialization file 
for a description of global and local options)

o        Save changes on exit.

This option determines whether changes to program options are to be saved at program 
termination.
Default: YES

o        Prompt for icon delete.

This option determines whether the user is prompted whenever an icon is deleted.
Default: NO

o        Backup Group Files

This option determines whether a backup copy of the affected Program Manager group file is made
whenever a Program Manager icon is replaced. (Windows 3.0 only)
Default YES

o        Icon editor.

Name of your icon editor.    If your editor is not located in a directory that is included on the PATH 
statement in your AUTOEXEC.BAT file, then the complete path to your icon editor must be 
specified here.
Default: AzIconEdit



Program Exit Command    (File Menu)

The Program Exit command is used to close all icon viewing windows and exit Icon Power.    All current 
window sizes and positions will be saved into the "ICNPWR.INI" file to be used then next time Icon Power
is started.



Closing all Icon Power Viewing Windows

All Icon Power viewing windows may be closed at one time by selecting the Exit command from Icon 
Power's File Menu.



Edit Menu Items

Edit Icon                             
Rename                              
Delete                                  
Paste                                   
Rescan Icons                      



Edit Icon Command    (Edit Menu)

When an icon has been selected, clicking on the Edit Icon menu item will command Icon Power to call the
icon editor that has been specified in the program options dialog box. The name of the icon file you 
selected will be passed to your icon editor as a command line argument.

You may also start up your icon editing program by simply double clicking on the icon that you wish to 
edit.

NOTES:

1.    You may also use the shortcut key "Control+E" to edit the selected icon file.

2.    Not all icon editors have command line support for the name of the icon file to be edited.    Refer to the
documentation of your icon editor for details.

3.    If the Edit Icon command is selected while Icon Power is viewing an EXE or DLL file, a copy of the 
selected icon will be made and written to the current directory as a .ICO file before calling the icon 
editor.



Rename Icon Command    (Edit Menu)

When an icon has been selected, clicking on the Rename Icon menu item will command Icon Power to 
open a dialog box showing both the old and new name.    To change the name of an icon file, enter a new 
name and click the OK button.

NOTE:

You may also use the shortcut key "Control+R" to rename the selected icon file.



Delete Icon Command    (Edit Menu)

When an icon has been selected, clicking on the Delete menu item will command Icon Power to delete 
the selected icon file.    If the "Prompt_For_Delete" option is on, you will be prompted for an OK before 
deleting the icon file.

NOTE:

You may also use the shortcut key "DEL" to delete the selected icon file.



Paste Icon Command    (Edit Menu)

When an icon has been selected, clicking on the Paste Icon menu item will command Icon Power to paste
a copy of the selected icon to the clipboard where it may be accessed by other applications.

NOTE:

You may also use the shortcut key "Control+P" to paste the selected icon to the clipboard.



Rescan Icons Command    (Edit Menu)

The Rescan Icons command is used to rescan the current directory and refresh the display.

NOTE:

You may also use the shortcut key "Control+S" to rescan the current directory.



Window Menu Items

The Window Menu includes commands that allow you to open a new icon viewing window or open an 
icon editing window.

New Window                      
Edit Window                       



New Window Command    (Window Menu)

Opens a new icon viewing window.    Use the File menu's "View Icon Files" or "View EXE/DLL File " to 
select either a disk directory or an EXE/DLL file that contains icons that you wish to view.    Icon Power will
remember the size, position, directory and file filter for each display window that is opened and recreate 
those same conditions every time the program is executed.

Individual viewing windows may be closed by double clicking on the "System Menu Bar".    To close all 
viewing windows, select "Exit" from Icon Power's File menu.



Edit Window Command    (Window Menu)

Opens an editing window by calling the icon editor that has been specified in the "Program Options" 
dialog box.



Selecting an Icon

Icons may be individually selected/deselected by positioning the cursor over the desired icon and clicking 
the left or right mouse button. When an icon has been selected, a "select box" will be drawn around the 
desired icon and    the Edit menu items listed below will be enabled.    

Edit Icon          
Rename           
Delete              
Paste               



Help Menu Items

Index                              Icon Power Main Help Index
Using Help  Instruction on how to use HELP
About  Information about Icon Power.



Initialization File

The operation of Icon Power is controlled by an initialization file that is read during program startup. This 
file, (ICNPWR.INI), must be located in the same directory as the ICNPWR.EXE executable file. If the 
ICNPWR.INI file is not present when Icon Power is started, it will be created with a default set of options. 
The options contained in this file are maintained automatically by the Icon Power program and no action 
by the user is required. If it is desired, the user may set any of the program options directly by using any 
text editor to edit the ICNPWR.INI file. The options in this file are in the same format as those used by the 
Windows 3.0/3.1 initialization file (WIN.INI).

There are presently two sets of options that are maintained by Icon Power, global and local.    The global 
options affect all instances of Icon Power and are listed under the heading of [ICNPWR] in the 
ICNPWR.INI file. The local options affect only the individual instances of Icon Power whose instance 
heading they fall under ([INST1], [INST2] ...).

Refer to the topics on global and local options for further details.



Initialization File - Global Options

The available global options are:

o        Icon_Editor

Name of your icon editor.    If your editor is not located in a directory that is included on the PATH 
statement in your AUTOEXEC.BAT file, then the complete path to your icon editor must be 
specified here.
Default: AzIconEdit

o        Save_Changes

This option determines whether changes to program options are to be saved at program 
termination.
Default: YES

o        Prompt_For_Delete

This option determines whether the user is prompted whenever an icon is deleted.
Default: NO

o      Backup_Group_Files

This option determines whether a backup copy of a Program Manager group file is made whenever
a Program Manager icon is replaced.    (Windows 3.0 only)
Default: YES



Initialization File - Local Options

The available local options are:

o        Icon_Directory

Complete path for directory containing the icons to be viewed.    
Default: Directory where ICNPWR.EXE is located.

o        File_Filter

File filter used by Icon Power when making a list of icon files to be viewed.
Default: *.ICO

o XORG, YORG, XSIZE, YSIZE

These options are used by the program to remember the size and position of the display window 
for each instance of Icon Power that is running. These options are maintained automatically by Icon
Power and no action by the user is required.



Keyboard

Many of Icon Power's functions that are normally performed with a mouse may also be performed by 
using the keyboard.    Here is a list of keys that are supported and the functions they perform:

Up Arrow Move mouse pointer up one icon.
Down Arrow Move mouse pointer down one icon.
Left Arrow Move mouse pointer to the left one icon.
Right Arrow Move mouse pointer to the right one icon.
Page Down Display next page of icons.
Page Up Display previous page of icons.
Home Display first page of icons.
End Display last page of icons.
Enter Select/deselect icon under mouse pointer.

Shortcut keys:

Control+E Edit selected icon.
Control+R Rename selected icon.
Control+P Paste selected icon to clipboard
Control+S Rescan current directory and refresh display.
DEL Delete selected icon.




